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Introduction

Electrostatic chucks (e-chucks) play an important role in various wafer-processing 
equipment. Instead of mechanical clamping, an e-chuck uses an electromechanical force 
to secure a wafer on a temperature-controlled platform that cools or heats the wafer during 
processing. Usually, wafers are warped so e-chucks are also used in lithographic tools to 
flatten wafers during exposure. This model demonstrates the basics of e-chuck operation 
resulting from the couplings of electrostatic force, gas flow, heat transfer, and solid 
mechanics in the context of wafer cooling. In this model, an electrostatic force counters 
the pressure from helium gas flowing in the gap between the wafer and the e-chuck to 
provide efficient thermal conduction in an otherwise low pressure environment.

Model Definition

This 2D axisymmetric model comprises three regions to represent the wafer (deformable), 
two dielectric blocks (rigid), and a gas channel. The dielectric blocks are the only parts of 
the e-chuck that are explicitly included in the geometry. The silicon wafer (diameter = 
100 mm) sits on a stand-off at the edge of the outer dielectric block and is suspended 
above the dielectric blocks, forming a 40 μm-gap. This gap region is specified as a Fluid 

Properties domain, in which the flow of helium gas is solved for. At the edge, the wafer and 
the stand-off on the e-chuck are in contact but the wafer is able to slide or detach 
depending on the resultant force on it. The wafer’s center is suspended above the e-chuck 
surface but can come into contact with the e-chuck if the applied bias exceeds the pull-in 
voltage. To allow for large displacements, a Deforming Domain is applied to the gap between 
the wafer and dielectric blocks. An electromechanical force between the wafer and the e-
chuck results from applying Terminal boundaries to the bottom of the wafer and the 
dielectric blocks. The model geometry is shown in Figure 1. The y-axis is scaled by a factor 
of 20 to better show the narrow gap between the wafer and the e-chuck.
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Figure 1: The model geometry.

This model solves for the combinations of applied voltage and gas flow required to keep 
the wafer securely in place as characterized by the z-displacement of a point on the bottom 
surface of the wafer positioned 32 mm from the center. This point is labeled p17 in the 
geometry. As long as p17 is below z = 40 μm, the wafer experiences a net downward force. 
COMSOL Multiphysics can then solve for the DC voltage that must be applied to the 
wafer to move p17 to the specified z-coordinate setpoint, or zsp. This is achieved by 
adding a global equation for the DC voltage, VdcSP, which is applied at the bottom of the 
dielectric blocks. The equation intop1(z)-zsp=0 is then solved to determine the value 
of VdcSP. This means that VdcSP is adjusted until p17 is at zsp. Solving the problem in 
this manner avoids complications when the problem has no solution. The result of the 
analysis is a plot of displacement versus applied voltage.

P H Y S I C S  I N T E R F A C E S

The model uses four interfaces: Laminar Flow, Solid Mechanics, Heat Transfer in Solids and 

Fluids (which are built into the Fluid-Solid Interaction from Conjugate Heating), and 
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Electrostatics. With these four interfaces, the available Multiphysics couplings are Fluid-

Structure Interaction, Nonisothermal Flow, and Electromechanical Forces.

M A T E R I A L  P R O P E R T I E S

Silicon and aluminum oxide material models are used for the wafer and the dielectrics, 
respectively. To simulate heat transfer between the wafer and the e-chuck via helium gas, 
the model applies a user-defined function for thermal conductivity that is pressure 
dependent in the form of 

where k is the thermal conductivity in W/(m·K) and p is the pressure in Torr. This user-
defined function is specified in the material model for helium using a piecewise linear 
function.

B O U N D A R Y  C O N D I T I O N S

Laminar Flow
A Laminar Flow interface is applied to the region between the wafer and the dielectric 
blocks. An Inlet boundary is applied with mass flow in standard flow rate (SCCM) and a 
mean molar mass of 0.004 kg/mol for helium gas.

Solid Mechanics
Two Contact boundaries are applied at the contact points between the wafer and the e-
chuck. The first contact boundary is at the edge of the wafer where it is in contact with the 
e-chuck. The second contact boundary is in the middle of the wafer to constrain the 
displacement of the wafer when pull-in occurs. Gravity (a volume force) is applied to the 
wafer. Solid Mechanics is only applied to the wafer because the dielectric blocks of the e-
chuck can be assumed rigid.

Heat Transfer in Solids and Fluids
This model applies Initial Values to the wafer as the initial condition in the time-dependent 
simulation. Time-dependent Heat Flux is applied to the top surface of the wafer to 
represent a heat pulse from a plasma process. The Heat Transfer interface is applied to the 
entire geometry.

Electrostatics
The Electrostatics interface is applied to the entire geometry. The voltage required to hold 
the wafer in place depends on the pressure from the helium flow. In this model, an 
Integration Operator is used to access the z-coordinate of p17. Then, the Global Equation 

k p( ) 0.045809 10 p( )log( ) 0.006317+=
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intop1(z)-zsp=0 can be solved for the value of VdcSP needed to hold p17 at the setpoint 
zsp. Terminal boundaries are applied to the bottom of the wafer and the dielectric blocks.

Deforming Domain
The mesh in the rectangular region between the wafer and the e-chuck is set to deform 
freely, following a hyperelastic mesh smoothing deformation. The mesh displacement is 
controlled by the structural displacement of the wafer boundaries. At the dielectric blocks 
boundaries, a fixed boundary is used.

S T U D I E S  A N D  S T R A T E G Y  F O R  C O N V E R G E N C E

This highly nonlinear problem requires ramping of a parameter such as the helium flow 
rate for it to converge to a solution. The studies should be done in steps with an increasing 
number of coupled interfaces. The solution of a previous study can be used as the initial 
value by a subsequent study:

• Study 1: Only Solid Mechanics and Electrostatics are enabled to study voltage conditions 
without gas flow. The study computes the wafer’s profile when zsp is set to 35, 25, and 
15 μm. When zsp = 15 μm, the center of the wafer is in contact with the e-chuck.

• Study 2: The Solid Mechanics, Electrostatics, and Laminar Flow interfaces are enabled to 
study voltage conditions when the mass flow rate is set to 0, 100, 200, 300, and 
400 SCCM and zsp = 30 μm. This study computes the wafer profile and the pressure 
field within the fluid region.

• Study 3: In this time-dependent study, all four interfaces, including Heat Transfer, are 
enabled. This study uses the solution of Study 2 as the initial solution to solve for the 
temperature field resulting from heat transfer between the e-chuck and the wafer and 
the plasma process.

Moreover, the use of Global Equations and the coupled physics necessitates adjustments 
to the solver settings. In this model, the Fully Coupled solver with Automatic highly 
nonlinear Newton method is required instead of the default Segregated solver.

Results and Discussion

In Study 1, p17 is set to 35, 25, and 15 um without helium gas flowing. The resulting wafer 
profile is shown in Figure 2. VdcSP versus z-displacement at p17 is shown in Figure 3. In 
Study 2, zsp is set to 30 μm and the helium gas flow = 0, 100, 200, 300, and 400 SSCM. 
The resulting wafer profile is shown in Figure 4 and the plot of VdcSP versus helium flow 
rate is shown in Figure 5. The surface plot of the displacement and the deformation is 
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shown in Figure 6. In the time-dependent Study 3, a heat pulse is introduced, resulting in 
the plot of wafer temperature versus time shown in Figure 7. 

Figure 2: Wafer profile when zsp is set to 35, 25, and 15 μm without helium gas flowing. As 
expected. The structural displacement is maximal at the center of the geometry. For 
zsp = 15 μm, the center of the wafer is in contact with the e-chuck.
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Figure 3: VdcSP versus zsp = 35, 25, or 15 μm, without helium gas flowing.
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Figure 4: Wafer profile when zsp = 30 μm with helium gas flow = 0, 100, 200, 300, and 
400 SCCM.
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Figure 5: VdcSP versus helium gas flow for zsp = 30 μm. Helium gas flow = 0, 100, 200, 300, 
or 400 SCCM.
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Figure 6: Surface Plot and Deformation for zsp = 30 μm and helium gas flow = 400 SCCM.
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Figure 7: Time-dependent surface temperature at the center of the wafer with helium gas flow 
of 300 SCCM.

Application Library path: MEMS_Module/Actuators/electrostatic_chuck

Modeling Instructions

Start by creating a new 2D axisymmetric model with (i) Fluid-Solid Interaction, (ii) 
Electrostatics (physics), and (iii) Electromechanical Forces (multiphysics). Built-in to the 
Fluid-Solid Interaction are Physics for Laminar Flow, Solid Mechanics, and Heat Transfer 
in Solids and Fluids.

From the File menu, choose New.

N E W

In the New window, click Model Wizard.
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M O D E L  W I Z A R D

1 In the Model Wizard window, click 2D Axisymmetric.

2 In the Select Physics tree, select Fluid Flow>Fluid-Structure Interaction>

Conjugate Heat Transfer>Fluid-Solid Interaction.

3 Click Add.

4 In the Select Physics tree, select AC/DC>Electric Fields and Currents>Electrostatics (es).

5 Click Add.

6 Click Done.

M U L T I P H Y S I C S

Electromechanical Forces 1 (eme1)
In the Physics toolbar, click Multiphysics Couplings and choose Domain>

Electromechanical Forces.

Import parameters for Geometry, Mesh, and Process for convenience.

G L O B A L  D E F I N I T I O N S

Geometry
1 In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, type Geometry in the Label text field.

3 Locate the Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
electrostatic_chuck_geometry_parameters.txt.

Mesh
1 In the Home toolbar, click Parameters and choose Add>Parameters.

2 In the Settings window for Parameters, type Mesh in the Label text field.

3 Locate the Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
electrostatic_chuck_mesh_parameters.txt.

Process
1 In the Home toolbar, click Parameters and choose Add>Parameters.

2 In the Settings window for Parameters, type Process in the Label text field.

3 Locate the Parameters section. Click Load from File.
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4 Browse to the model’s Application Libraries folder and double-click the file 
electrostatic_chuck_process_parameters.txt.

D E F I N I T I O N S

Rectangle 1 (rect1)
1 In the Home toolbar, click Functions and choose Local>Rectangle.

2 In the Settings window for Rectangle, locate the Parameters section.

3 In the Lower limit text field, type t_start.

4 In the Upper limit text field, type t_start+t_pulse.

Variables 1
1 In the Model Builder window, right-click Definitions and choose Variables.

2 In the Settings window for Variables, locate the Variables section.

3 In the table, enter the following settings:

Set the geometry unit to millimeters for convenience.

G E O M E T R Y  1

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose mm.

The geometry is comprised of wafer, insulator, gap, inlet, and outlet.

Wafer
1 In the Geometry toolbar, click Rectangle.

2 In the Settings window for Rectangle, type Wafer in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type d_wafer/2.

4 In the Height text field, type t_wafer.

5 Locate the Position section. In the z text field, type gap.

6 Locate the Selections of Resulting Entities section. Find the Cumulative selection 
subsection. Click New.

7 In the New Cumulative Selection dialog box, type Selection: Wafer in the Name text 
field.

Name Expression Unit Description

Qt Q_plasma*rect1(t) W/m²
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8 Click OK.

Gap 1
1 In the Geometry toolbar, click Rectangle.

2 In the Settings window for Rectangle, type Gap 1 in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type x_outlet.

4 In the Height text field, type gap.

Gap 2
1 In the Geometry toolbar, click Rectangle.

2 In the Settings window for Rectangle, type Gap 2 in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type x_gap3-x_outlet.

4 In the Height text field, type gap.

5 Locate the Position section. In the r text field, type x_outlet.

Gap 3
1 In the Geometry toolbar, click Rectangle.

2 In the Settings window for Rectangle, type Gap 3 in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type w_gap3.

4 In the Height text field, type gap.

5 Locate the Position section. In the r text field, type x_gap3.

Pin
1 In the Geometry toolbar, click Rectangle.

2 In the Settings window for Rectangle, type Pin in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type d_pin.

4 In the Height text field, type gap.

5 Locate the Position section. In the r text field, type x_gap3+w_gap3.

6 Locate the Selections of Resulting Entities section. Find the Cumulative selection 
subsection. Click New.

7 In the New Cumulative Selection dialog box, type Insulator in the Name text field.

8 Click OK.

Rectangle 6 (r6)
In the Geometry toolbar, click Rectangle.
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G E O M E T R Y  1

Insulator 1
1 In the Model Builder window, expand the Component 1 (comp1)>Definitions>View 1 

node, then click Component 1 (comp1)>Geometry 1>Rectangle 6 (r6).

2 In the Settings window for Rectangle, type Insulator 1 in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type x_outlet-d_inlet/2.

4 In the Height text field, type t_insulator.

5 Locate the Position section. In the r text field, type d_inlet/2.

6 In the z text field, type -t_insulator.

7 Locate the Selections of Resulting Entities section. Find the Cumulative selection 
subsection. From the Contribute to list, choose Insulator.

Insulator 2
1 In the Geometry toolbar, click Rectangle.

2 In the Settings window for Rectangle, type Insulator 2 in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type x_gap3+w_gap3+d_pin-
x_outlet-w_outlet.

4 In the Height text field, type t_insulator.

5 Locate the Position section. In the r text field, type x_outlet+w_outlet.

6 In the z text field, type -t_insulator.

7 Locate the Selections of Resulting Entities section. Find the Cumulative selection 
subsection. From the Contribute to list, choose Insulator.

Inlet
1 In the Geometry toolbar, click Rectangle.

2 In the Settings window for Rectangle, type Inlet in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type d_inlet/2.

4 In the Height text field, type L_inlet+t_insulator.

5 Locate the Position section. In the z text field, type -L_inlet-t_insulator+gap.

Outlet
1 In the Geometry toolbar, click Rectangle.

2 In the Settings window for Rectangle, type Outlet in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type w_outlet.

4 In the Height text field, type L_outlet+t_insulator.
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5 Locate the Position section. In the r text field, type x_outlet.

6 In the z text field, type -L_inlet-t_insulator+gap.

Union 1 (uni1)
1 In the Geometry toolbar, click Booleans and Partitions and choose Union.

2 Select the objects r1, r2, r3, r4, r8, and r9 only.

Union 2 (uni2)
1 In the Geometry toolbar, click Booleans and Partitions and choose Union.

2 Select the objects r5, r6, and r7 only.

Partition the domains so that two contact regions can be created.

Partition Domains 1 (pard1)
1 In the Geometry toolbar, click Booleans and Partitions and choose 

Partition Domains.

2 In the Settings window for Partition Domains, locate the Partition Domains section.

3 Find the Vertices defining line segments subsection. Click to select the 
Activate Selection toggle button.

4 From the Partition with list, choose Extended edges.

5 Find the Domains to partition subsection. Click to select the Activate Selection 
toggle button.

6 Find the Straight or circular edges subsection. Click to select the Activate Selection 
toggle button.

7 On the object uni2, select Boundary 2 only.

8 Find the Domains to partition subsection. Click to select the Activate Selection 
toggle button.

9 On the object uni1, select Domain 1 only.

Partition Domains 2 (pard2)
1 In the Geometry toolbar, click Booleans and Partitions and choose 

Partition Domains.

2 On the object pard1, select Domain 6 only.

3 In the Settings window for Partition Domains, locate the Partition Domains section.

4 Find the Vertices defining line segments subsection. Click to select the 
Activate Selection toggle button.

5 From the Partition with list, choose Extended edges.
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6 On the object uni2, select Boundary 2 only.

Partition Domains 3 (pard3)
1 In the Geometry toolbar, click Booleans and Partitions and choose 

Partition Domains.

2 On the object uni2, select Domain 2 only.

3 In the Settings window for Partition Domains, locate the Partition Domains section.

4 Find the Vertices defining line segments subsection. Click to select the 
Activate Selection toggle button.

5 From the Partition with list, choose Extended edges.

6 On the object pard2, select Boundary 27 only.

Partition Domains 4 (pard4)
1 In the Geometry toolbar, click Booleans and Partitions and choose 

Partition Domains.

2 On the object pard2, select Domain 4 only.

3 In the Settings window for Partition Domains, locate the Partition Domains section.

4 Find the Vertices defining line segments subsection. Click to select the 
Activate Selection toggle button.

5 From the Partition with list, choose Extended edges.

6 On the object pard3, select Boundaries 5 and 8 only.

Form Union (fin)
1 In the Model Builder window, under Component 1 (comp1)>Geometry 1 click 

Form Union (fin).

2 In the Settings window for Form Union/Assembly, locate the Form Union/Assembly section.

3 From the Action list, choose Form an assembly. This is necessary because the model 
includes moving objects.

4 Clear the Create pairs check box.

5 Click Build Selected.

D E F I N I T I O N S

Axis
1 In the Model Builder window, under Component 1 (comp1)>Definitions>View 1 click Axis.

2 In the Settings window for Axis, locate the Axis section.

3 From the View scale list, choose Manual.
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4 In the y scale text field, type 20.

5 Click Update.

View 1
1 In the Model Builder window, click View 1.

2 In the Settings window for View, locate the View section.

3 Select the Show geometry labels check box.

Add a nonlocal integration coupling to compute the actual displacement.

Integration 1 (intop1)
1 In the Definitions toolbar, click Nonlocal Couplings and choose Integration.

2 In the Settings window for Integration, locate the Source Selection section.

3 From the Geometric entity level list, choose Point.

4 Click Paste Selection.

5 In the Paste Selection dialog box, type 17 in the Selection text field.

6 Click OK.

7 In the Settings window for Integration, locate the Advanced section.

8 Clear the Compute integral in revolved geometry check box.

Add a Contact Pair and an Identity Boundary Pair.

Contact Pair 1 (p1)
1 In the Definitions toolbar, click Pairs and choose Contact Pair.

2 In the Settings window for Pair, locate the Source Boundaries section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 47 49 51 in the Selection text field.

5 Click OK.

6 In the Settings window for Pair, locate the Destination Boundaries section.

7 Click to select the Activate Selection toggle button.

8 Click Paste Selection.

9 In the Paste Selection dialog box, type 32 35 in the Selection text field.

10 Click OK.

11 In the Settings window for Pair, locate the Advanced section.

12 From the Mapping method list, choose Initial configuration.
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Contact Pair 2 (p2)
1 In the Definitions toolbar, click Pairs and choose Contact Pair.

2 In the Settings window for Pair, locate the Source Boundaries section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 37 39 40 in the Selection text field.

5 Click OK.

6 In the Settings window for Pair, locate the Destination Boundaries section.

7 Click to select the Activate Selection toggle button.

8 Click Paste Selection.

9 In the Paste Selection dialog box, type 8 14 21 in the Selection text field.

10 Click OK.

11 In the Settings window for Pair, locate the Advanced section.

12 From the Mapping method list, choose Initial configuration.

Identity Boundary Pair 3 (p3)
1 In the Definitions toolbar, click Pairs and choose Identity Boundary Pair.

2 In the Settings window for Pair, locate the Source Boundaries section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 37 39 40 41 43 46 47 49 in the Selection text 
field.

5 Click OK.

6 In the Settings window for Pair, locate the Destination Boundaries section.

7 Click to select the Activate Selection toggle button.

8 Click Paste Selection.

9 In the Paste Selection dialog box, type 13 25 30 34 35 in the Selection text field.

10 Click OK.

Add an explicit selection for the fluid domain.

Fluid
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Fluid in the Label text field.

3 Locate the Input Entities section. Click Paste Selection.

4 In the Paste Selection dialog box, type 1 2 3 5 6 7 8 9 11 in the Selection text field.
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5 Click OK.

M O V I N G  M E S H

Deforming Domain 1
1 In the Model Builder window, under Component 1 (comp1)>Moving Mesh click 

Deforming Domain 1.

2 In the Settings window for Deforming Domain, locate the Domain Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 3 5 8 9 11 in the Selection text field.

5 Click OK.

6 In the Settings window for Deforming Domain, locate the Smoothing section.

7 From the Mesh smoothing type list, choose Hyperelastic.

Add materials to the model.

A D D  M A T E R I A L

1 In the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select MEMS>Insulators>Al2O3 - Aluminum oxide.

4 Click Add to Component in the window toolbar.

M A T E R I A L S

Al2O3 - Aluminum oxide (mat1)
1 In the Settings window for Material, locate the Geometric Entity Selection section.

2 From the Selection list, choose Insulator.

A D D  M A T E R I A L

1 Go to the Add Material window.

2 In the tree, select MEMS>Semiconductors>Si - Silicon (single-crystal, isotropic).

3 Click Add to Component in the window toolbar.

M A T E R I A L S

Si - Silicon (single-crystal, isotropic) (mat2)
1 In the Settings window for Material, locate the Geometric Entity Selection section.

2 From the Selection list, choose Selection: Wafer.
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A D D  M A T E R I A L

1 Go to the Add Material window.

2 In the tree, select Liquids and Gases>Gases>Helium.

3 Click Add to Component in the window toolbar.

4 In the Home toolbar, click Add Material to close the Add Material window.

M A T E R I A L S

Helium (mat3)
1 In the Settings window for Material, locate the Geometric Entity Selection section.

2 From the Selection list, choose Fluid.

3 In the Model Builder window, expand the Helium (mat3) node.

Define a piecewise continuous function for the pressure-dependent thermal conductivity 
of the gas.

Piecewise 3 (k)
1 In the Model Builder window, expand the Component 1 (comp1)>Materials>

Helium (mat3)>Basic (def) node, then click Piecewise 3 (k).

2 In the Settings window for Piecewise, locate the Definition section.

3 In the Argument text field, type pA.

4 Find the Intervals subsection. In the table, enter the following settings:

5 Locate the Units section. In the Arguments text field, type Torr.

Set up laminar flow boundary conditions.

L A M I N A R  F L O W  ( S P F )

1 In the Model Builder window, under Component 1 (comp1) click Laminar Flow (spf).

2 In the Settings window for Laminar Flow, locate the Domain Selection section.

3 From the Selection list, choose Fluid.

Initial Values 1
1 In the Model Builder window, under Component 1 (comp1)>Laminar Flow (spf) click 

Initial Values 1.

2 In the Settings window for Initial Values, locate the Initial Values section.

Start End Function

1 100 0.045809*log10(pA)+0.0063167
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3 In the p text field, type 0.1.

Flow Continuity 1
1 In the Model Builder window, click Flow Continuity 1.

2 In the Settings window for Flow Continuity, locate the Advanced section.

3 Select the Disconnect pair check box.

Specify an inlet boundary condition with Mass Flow in Standard flow rate (SCCM).

Inlet 1
1 In the Physics toolbar, click Boundaries and choose Inlet.

2 In the Settings window for Inlet, locate the Boundary Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 2 in the Selection text field.

5 Click OK.

6 In the Settings window for Inlet, locate the Boundary Condition section.

7 From the list, choose Mass flow.

8 Locate the Mass Flow section. From the Mass flow type list, choose 
Standard flow rate (SCCM).

9 In the Qsccm text field, type flow.

10 In the Mn text field, type mass_He.

Outlet 1
1 In the Physics toolbar, click Boundaries and choose Outlet.

2 In the Settings window for Outlet, locate the Boundary Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 16 in the Selection text field.

5 Click OK.

6 In the Settings window for Outlet, locate the Pressure Conditions section.

7 In the p0 text field, type 0.01[Torr].

8 Clear the Suppress backflow check box.

Set up solid-mechanics boundary conditions.

With the assumption that the electrostatic chuck is rigid and only the silicon wafer will be 
deformed, only the silicon domain is selected for the Solid Mechanics interface. This 
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reduces the computation load as the solid-mechanics degrees of freedom outside of the 
silicon domain are not solved for.

S O L I D  M E C H A N I C S  ( S O L I D )

1 In the Model Builder window, under Component 1 (comp1) click Solid Mechanics (solid).

2 In the Settings window for Solid Mechanics, locate the Domain Selection section.

3 From the Selection list, choose Selection: Wafer.

Gravity 1
In the Physics toolbar, click Global and choose Gravity.

Contact 1a
1 In the Physics toolbar, click Pairs and choose Contact.

Set up the contact condition between the wafer and the chuck surface.

2 In the Settings window for Contact, locate the Contact Pressure Penalty Factor section.

3 From the Penalty factor control list, choose Manual tuning.

4 In the fp text field, type 1/10.

5 Click to expand the Contact Surface Offset and Adjustment section. In the doffset,d text 
field, type 0.5[um].

6 Locate the Pair Selection section. Under Pairs, click Add.

7 In the Add dialog box, select Contact Pair 2 (p2) in the Pairs list.

8 Click OK.

Set up the contact condition between the wafer and the pin.

Contact 1
1 In the Model Builder window, click Contact 1.

2 In the Settings window for Contact, locate the Contact Pressure Penalty Factor section.

3 From the Penalty factor control list, choose Manual tuning.

4 In the fp text field, type 1/10.

5 Locate the Contact Surface Offset and Adjustment section. Select the Force zero initial gap 
check box.

Set up the heat-transfer boundary conditions.

H E A T  T R A N S F E R  I N  S O L I D S  A N D  F L U I D S  ( H T )

1 In the Model Builder window, under Component 1 (comp1) click 
Heat Transfer in Solids and Fluids (ht).
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2 In the Settings window for Heat Transfer in Solids and Fluids, locate the Domain Selection 
section.

3 In the list, select 16.

4 Click Remove from Selection.

5 Click in the Graphics window and then press Ctrl+A to select all domains.

6 Locate the Physical Model section. In the Tref text field, type T_chuck.

Solid 1
1 In the Model Builder window, under Component 1 (comp1)>

Heat Transfer in Solids and Fluids (ht) click Solid 1.

2 In the Settings window for Solid, locate the Model Input section.

3 From the Tref list, choose User defined. In the associated text field, type T_chuck.

4 From the pA list, choose Common model input.

Fluid 1
1 In the Model Builder window, click Fluid 1.

2 In the Settings window for Fluid, locate the Domain Selection section.

3 From the Selection list, choose Fluid.

Initial Values 1
1 In the Model Builder window, click Initial Values 1.

2 In the Settings window for Initial Values, locate the Initial Values section.

3 In the T text field, type T_chuck.

Solid 2 - Wafer
1 In the Physics toolbar, click Domains and choose Solid.

2 In the Settings window for Solid, locate the Domain Selection section.

3 From the Selection list, choose Selection: Wafer.

4 In the Label text field, type Solid 2 - Wafer.

5 Locate the Model Input section. From the Tref list, choose User defined. In the associated 
text field, type T_chuck.

6 From the pA list, choose Absolute pressure (spf).

Temperature 1
1 In the Physics toolbar, click Boundaries and choose Temperature.

2 In the Settings window for Temperature, locate the Boundary Selection section.
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3 Click Paste Selection.

4 In the Paste Selection dialog box, type 10 15 22 30 38 42 45 46 60 in the Selection 
text field.

5 Click OK.

6 In the Settings window for Temperature, locate the Temperature section.

7 In the T0 text field, type T_chuck.

Thermal Insulation 2
1 In the Physics toolbar, click Boundaries and choose Thermal Insulation.

2 In the Settings window for Thermal Insulation, locate the Boundary Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 46 48 in the Selection text field.

5 Click OK.

Specify a Heat Flux boundary condition to model the plasma process.

Heat Flux 1
1 In the Physics toolbar, click Boundaries and choose Heat Flux.

Set up a Heat Flux boundary condition along the top surface of the wafer.

2 In the Settings window for Heat Flux, locate the Boundary Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 9 28 33 in the Selection text field.

5 Click OK.

6 In the Settings window for Heat Flux, locate the Heat Flux section.

7 In the q0 text field, type Qt.

Initial Values 2
1 In the Physics toolbar, click Domains and choose Initial Values.

2 In the Settings window for Initial Values, locate the Domain Selection section.

3 From the Selection list, choose Selection: Wafer.

4 Locate the Initial Values section. In the T text field, type T_wafer_init.

Set up electromechanics boundary conditions.
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E L E C T R O S T A T I C S  ( E S )

Charge Conservation 1
1 In the Model Builder window, under Component 1 (comp1)>Electrostatics (es) click 

Charge Conservation 1.

2 In the Settings window for Charge Conservation, locate the Material Type section.

3 From the Material type list, choose Solid.

Charge Conservation 2
1 In the Physics toolbar, click Domains and choose Charge Conservation.

2 In the Settings window for Charge Conservation, locate the Domain Selection section.

3 From the Selection list, choose Fluid.

4 Locate the Constitutive Relation D-E section. From the εr list, choose User defined.

Continuity 1
1 In the Physics toolbar, click Pairs and choose Continuity.

2 In the Settings window for Continuity, locate the Pair Selection section.

3 Under Pairs, click Add.

4 In the Add dialog box, select Identity Boundary Pair 3 (p3) in the Pairs list.

5 Click OK.

Terminal 1
1 In the Physics toolbar, click Boundaries and choose Terminal.

2 In the Settings window for Terminal, locate the Boundary Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 8 14 21 27 32 35 in the Selection text field.

5 Click OK.

6 In the Settings window for Terminal, locate the Terminal section.

7 From the Terminal type list, choose Voltage.

8 In the V0 text field, type 0.

Change the drive potential to the value VdcSP, which will be solved for in a global 
equation.

Terminal 2
1 In the Physics toolbar, click Boundaries and choose Terminal.

2 In the Settings window for Terminal, locate the Boundary Selection section.
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3 Click Paste Selection.

4 In the Paste Selection dialog box, type 38 42 in the Selection text field.

5 Click OK.

6 In the Settings window for Terminal, locate the Terminal section.

7 From the Terminal type list, choose Voltage.

8 In the V0 text field, type VdcSP[V].

9 Click the Show More Options button in the Model Builder toolbar.

10 In the Show More Options dialog box, in the tree, select the check box for the node 
Physics>Equation-Based Contributions.

11 Click OK.

Add a global equation to compute the voltage for a given displacement, VdcSP.

Global Equations 1
1 In the Physics toolbar, click Global and choose Global Equations.

2 In the Settings window for Global Equations, locate the Global Equations section.

3 In the table, enter the following settings:

To define the structured mesh needed by the contact boundary conditions, several steps 
are required.

M E S H  1

Edge 1
1 In the Mesh toolbar, click Edge.

2 In the Settings window for Edge, locate the Boundary Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 2 4 6 8 in the Selection text field.

5 Click OK.

Distribution 1
1 Right-click Edge 1 and choose Distribution.

2 In the Settings window for Distribution, locate the Distribution section.

Name f(u,ut,utt,t) (1) Initial value 
(u_0) (1)

Initial value 
(u_t0) (1/s)

Description

VdcSP (intop1(z)-
zsp)/zsp

0 0
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3 In the Number of elements text field, type 10*(d_inlet/2).

Edge 2
1 In the Mesh toolbar, click Edge.

2 In the Settings window for Edge, locate the Boundary Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 16 18 20 21 in the Selection text field.

5 Click OK.

Distribution 1
1 Right-click Edge 2 and choose Distribution.

2 In the Settings window for Distribution, locate the Distribution section.

3 In the Number of elements text field, type 20*(w_outlet/2).

Edge 3
1 In the Mesh toolbar, click Edge.

2 In the Settings window for Edge, locate the Boundary Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 1 3 10 11 15 17 22 23 in the Selection text 
field.

5 Click OK.

Distribution 1
1 Right-click Edge 3 and choose Distribution.

2 In the Settings window for Distribution, locate the Distribution section.

3 From the Distribution type list, choose Predefined.

4 In the Number of elements text field, type my_inlet.

5 In the Element ratio text field, type 50.

6 Select the Reverse direction check box.

Edge 4
1 In the Mesh toolbar, click Edge.

2 In the Settings window for Edge, locate the Boundary Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 37 40 41 44 50 in the Selection text field.

5 Click OK.
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Distribution 1
1 Right-click Edge 4 and choose Distribution.

2 In the Settings window for Distribution, locate the Distribution section.

3 From the Distribution type list, choose Predefined.

4 In the Number of elements text field, type my_insulator.

5 In the Element ratio text field, type 2.

6 Select the Reverse direction check box.

Mapped 1 - Inlet and Outlet
1 In the Mesh toolbar, click Mapped.

2 In the Settings window for Mapped, type Mapped 1 - Inlet and Outlet in the Label 
text field.

3 Locate the Domain Selection section. From the Geometric entity level list, choose Domain.

4 Click Paste Selection.

5 In the Paste Selection dialog box, type 1 2 6 7 in the Selection text field.

6 Click OK.

Edge 5
1 In the Mesh toolbar, click Edge.

2 In the Settings window for Edge, locate the Boundary Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 5 12 19 24 29 34 47 51 in the Selection text 
field.

5 Click Cancel.

6 In the Settings window for Edge, locate the Boundary Selection section.

7 Click Paste Selection.

8 In the Paste Selection dialog box, type 5 12 19 24 29 34 47 51 in the Selection text 
field.

9 Click OK.

Distribution 1
1 Right-click Edge 5 and choose Distribution.

2 In the Settings window for Distribution, locate the Distribution section.

3 From the Distribution type list, choose Predefined.

4 In the Number of elements text field, type my_channel.
29 |  E L E C T R O S T A T I C  C H U C K



5 In the Element ratio text field, type 5.

6 Select the Symmetric distribution check box.

Mapped 2 - Corner
1 In the Mesh toolbar, click Mapped.

2 In the Settings window for Mapped, locate the Domain Selection section.

3 From the Geometric entity level list, choose Domain.

4 Click Paste Selection.

5 In the Paste Selection dialog box, type 3 8 in the Selection text field.

6 Click OK.

7 In the Settings window for Mapped, type Mapped 2 - Corner in the Label text field.

Edge 6
1 In the Mesh toolbar, click Edge.

2 In the Settings window for Edge, locate the Boundary Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 13 25 38 39 42 43 in the Selection text field.

5 Click OK.

Distribution 1
1 Right-click Edge 6 and choose Distribution.

2 In the Settings window for Distribution, locate the Boundary Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 13 in the Selection text field.

5 Click OK.

6 In the Settings window for Distribution, locate the Boundary Selection section.

7 Click Clear Selection.

8 Click Paste Selection.

9 In the Paste Selection dialog box, type 13 in the Selection text field.

10 Click OK.

11 In the Settings window for Distribution, locate the Distribution section.

12 In the Number of elements text field, type mfx*x_outlet.

Distribution 2
1 In the Model Builder window, right-click Edge 6 and choose Distribution.
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2 In the Settings window for Distribution, locate the Boundary Selection section.

3 Click Clear Selection.

4 Click Paste Selection.

5 In the Paste Selection dialog box, type 25 in the Selection text field.

6 Click OK.

7 In the Settings window for Distribution, locate the Distribution section.

8 In the Number of elements text field, type mfx*(d_wafer/2-x_outlet).

Distribution 3
1 Right-click Edge 6 and choose Distribution.

2 In the Settings window for Distribution, locate the Boundary Selection section.

3 Click Clear Selection.

4 Click Paste Selection.

5 In the Paste Selection dialog box, type 38 39 in the Selection text field.

6 Click OK.

7 In the Settings window for Distribution, locate the Distribution section.

8 In the Number of elements text field, type 2*x_outlet.

Distribution 4
1 Right-click Edge 6 and choose Distribution.

2 In the Settings window for Distribution, locate the Boundary Selection section.

3 Click Clear Selection.

4 Click Paste Selection.

5 In the Paste Selection dialog box, type 42 43 in the Selection text field.

6 Click OK.

7 In the Settings window for Distribution, locate the Distribution section.

8 In the Number of elements text field, type 2*(d_wafer/2-x_outlet).

Mapped - Channel
1 In the Mesh toolbar, click Mapped.

2 In the Settings window for Mapped, locate the Domain Selection section.

3 From the Geometric entity level list, choose Domain.

4 Click Paste Selection.

5 In the Paste Selection dialog box, type 5 9 in the Selection text field.
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6 Click OK.

7 In the Settings window for Mapped, type Mapped - Channel in the Label text field.

Mapped - Insulator
1 In the Mesh toolbar, click Mapped.

2 In the Settings window for Mapped, type Mapped - Insulator in the Label text field.

3 Locate the Domain Selection section. From the Geometric entity level list, choose Domain.

4 Click Paste Selection.

5 In the Paste Selection dialog box, type 13 14 in the Selection text field.

6 Click OK.

Edge 7
1 In the Mesh toolbar, click Edge.

2 In the Settings window for Edge, locate the Boundary Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 30 32 49 in the Selection text field.

5 Click OK.

Distribution 1
1 Right-click Edge 7 and choose Distribution.

2 In the Settings window for Distribution, locate the Boundary Selection section.

3 Click Clear Selection.

4 Click Paste Selection.

5 In the Paste Selection dialog box, type 49 in the Selection text field.

6 Click OK.

7 In the Settings window for Distribution, locate the Distribution section.

8 From the Distribution type list, choose Predefined.

9 In the Number of elements text field, type my_channel.

Distribution 2
1 In the Model Builder window, right-click Edge 7 and choose Distribution.

2 In the Settings window for Distribution, locate the Boundary Selection section.

3 Click Clear Selection.

4 Click Paste Selection.

5 In the Paste Selection dialog box, type 30 32 in the Selection text field.
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6 Click OK.

7 In the Settings window for Distribution, locate the Distribution section.

8 From the Distribution type list, choose Predefined.

9 In the Number of elements text field, type 3*mx_pin.

10 In the Element ratio text field, type 2.

Mapped 5
1 In the Mesh toolbar, click Mapped.

2 In the Settings window for Mapped, locate the Domain Selection section.

3 From the Geometric entity level list, choose Domain.

4 Click Paste Selection.

5 In the Paste Selection dialog box, type 11 in the Selection text field.

6 Click OK.

Edge 8
1 In the Mesh toolbar, click Edge.

2 In the Settings window for Edge, locate the Boundary Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 46 in the Selection text field.

5 Click OK.

Distribution 1
1 Right-click Edge 8 and choose Distribution.

2 In the Settings window for Distribution, locate the Boundary Selection section.

3 Click Clear Selection.

4 Click Paste Selection.

5 In the Paste Selection dialog box, type 46 in the Selection text field.

6 Click OK.

7 In the Settings window for Distribution, locate the Distribution section.

8 From the Distribution type list, choose Predefined.

9 In the Number of elements text field, type 2.

10 Select the Symmetric distribution check box.

Mapped 6
1 In the Mesh toolbar, click Mapped.
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2 In the Settings window for Mapped, locate the Domain Selection section.

3 From the Geometric entity level list, choose Domain.

4 Click Paste Selection.

5 In the Paste Selection dialog box, type 16 in the Selection text field.

6 Click OK.

Edge 9
1 In the Mesh toolbar, click Edge.

2 In the Settings window for Edge, locate the Boundary Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 7 36 in the Selection text field.

5 Click OK.

Distribution 1
1 Right-click Edge 9 and choose Distribution.

2 In the Settings window for Distribution, locate the Distribution section.

3 In the Number of elements text field, type my_wafer.

Copy Edge 1
1 In the Model Builder window, right-click Mesh 1 and choose Copying Operations>

Copy Edge.

2 Select Boundaries 46 and 48 only.

3 In the Settings window for Copy Edge, locate the Destination Boundaries section.

4 Click to select the Activate Selection toggle button.

5 Select Boundary 45 only.

Mapped 7
1 In the Mesh toolbar, click Mapped.

2 In the Settings window for Mapped, locate the Domain Selection section.

3 From the Geometric entity level list, choose Domain.

4 Click Paste Selection.

5 In the Paste Selection dialog box, type 15 in the Selection text field.

6 Click OK.

Free Triangular 1
1 In the Mesh toolbar, click Free Triangular.
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2 In the Settings window for Free Triangular, locate the Domain Selection section.

3 From the Geometric entity level list, choose Domain.

4 Click Paste Selection.

5 In the Paste Selection dialog box, type 4 10 12 in the Selection text field.

6 Click OK.

7 In the Settings window for Free Triangular, click Build All.

Size 1
1 Right-click Free Triangular 1 and choose Size.

2 In the Settings window for Size, locate the Element Size section.

3 From the Predefined list, choose Finer.

Set up a Stationary study with a parametric sweep over the displacement set point, zsp, 
without gas flow.

A D D  S T U D Y

1 In the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select General Studies>Stationary.

4 Click Add Study in the window toolbar.

5 In the Home toolbar, click Add Study to close the Add Study window.

S T U D Y  1  -  W I T H O U T  G A S  F L O W

1 In the Model Builder window, click Study 1.

2 In the Settings window for Study, type Study 1 - Without Gas Flow in the Label text 
field.

3 Locate the Study Settings section. Clear the Generate default plots check box.

Step 1: Stationary
1 In the Model Builder window, under Study 1 - Without Gas Flow click Step 1: Stationary.

2 In the Settings window for Stationary, locate the Physics and Variables Selection section.

3 In the table, enter the following settings:

Physics interface Solve for Equation form

Laminar Flow (spf) Automatic (Stationary)

Solid Mechanics (solid) √ Automatic (Stationary)
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4 In the table, enter the following settings:

5 Click to expand the Values of Dependent Variables section. Click to expand the 
Study Extensions section. Select the Auxiliary sweep check box.

6 Click Add.

7 In the table, enter the following settings:

The problem is highly nonlinear due to coupled physics and the presence of the global 
equation, so the solver settings need to be adjusted accordingly.

Solution 1 (sol1)
1 In the Study toolbar, click Show Default Solver.

2 In the Model Builder window, expand the Solution 1 (sol1) node.

3 In the Model Builder window, expand the Study 1 - Without Gas Flow>

Solver Configurations>Solution 1 (sol1)>Stationary Solver 1 node.

4 Right-click Study 1 - Without Gas Flow>Solver Configurations>Solution 1 (sol1)>

Stationary Solver 1 and choose Fully Coupled.

5 In the Settings window for Fully Coupled, click to expand the Method and Termination 
section.

6 From the Nonlinear method list, choose Automatic highly nonlinear (Newton).

7 In the Maximum number of iterations text field, type 200.

8 In the Study toolbar, click Compute.

Heat Transfer in Solids and Fluids 
(ht)

Automatic (Stationary)

Electrostatics (es) √ Automatic (Stationary)

Moving mesh (Component 1) √ Automatic

Multiphysics couplings Solve for Equation form

Fluid-Structure Interaction 1 (fsi1) Automatic (Stationary)

Nonisothermal Flow 1 (nitf1) Automatic (Stationary)

Thermal Expansion 1 (te1) Automatic (Stationary)

Parameter name Parameter value list Parameter unit

zsp (Z-coordinate of setpoint) 35[um] 25[um] 15[um] m

Physics interface Solve for Equation form
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Set up a Stationary study with a parametric sweep over the displacement set point, zsp, 
with gas flow.

A D D  S T U D Y

1 In the Study toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select General Studies>Stationary.

4 Click Add Study in the window toolbar.

5 In the Study toolbar, click Add Study to close the Add Study window.

S T U D Y  2  -  W I T H  G A S  F L O W

1 In the Model Builder window, click Study 2.

2 In the Settings window for Study, type Study 2 - with Gas Flow in the Label text field.

3 Locate the Study Settings section. Clear the Generate default plots check box.

Step 1: Stationary
1 In the Model Builder window, under Study 2 - with Gas Flow click Step 1: Stationary.

2 In the Settings window for Stationary, locate the Physics and Variables Selection section.

3 In the table, enter the following settings:

4 In the table, enter the following settings:

5 Locate the Study Extensions section. Select the Auxiliary sweep check box.

6 From the Sweep type list, choose All combinations.

7 Click Add.

Physics interface Solve for Equation form

Laminar Flow (spf) √ Automatic (Stationary)

Solid Mechanics (solid) √ Automatic (Stationary)

Heat Transfer in Solids and Fluids 
(ht)

Automatic (Stationary)

Electrostatics (es) √ Automatic (Stationary)

Moving mesh (Component 1) √ Automatic

Multiphysics couplings Solve for Equation form

Thermal Expansion 1 (te1) Automatic (Stationary)
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8 In the table, enter the following settings:

9 Click Add.

10 In the table, enter the following settings:

The problem is highly nonlinear due to coupled physics and the presence of the global 
equation, so the solver settings need to be adjusted accordingly.

Solution 2 (sol2)
1 In the Study toolbar, click Show Default Solver.

2 In the Model Builder window, expand the Solution 2 (sol2) node.

3 In the Model Builder window, expand the Study 2 - with Gas Flow>Solver Configurations>

Solution 2 (sol2)>Stationary Solver 1 node.

4 Right-click Study 2 - with Gas Flow>Solver Configurations>Solution 2 (sol2)>

Stationary Solver 1 and choose Fully Coupled.

5 In the Settings window for Fully Coupled, locate the General section.

6 From the Linear solver list, choose Direct.

7 Locate the Method and Termination section. From the Nonlinear method list, choose 
Automatic highly nonlinear (Newton).

8 In the Maximum number of iterations text field, type 500.

9 In the Study toolbar, click Compute.

Set up a Time Dependent study with a Heat Flux boundary condition on the wafer surface 
to model heating from the plasma.

A D D  S T U D Y

1 In the Study toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select General Studies>

Time Dependent.

4 Click Add Study in the window toolbar.

Parameter name Parameter value list Parameter unit

flow (Mass flow in SCCM) range(0,100,400) 1

Parameter name Parameter value list Parameter unit

zsp (Z-coordinate of setpoint) 30[um] m
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5 In the Study toolbar, click Add Study to close the Add Study window.

S T U D Y  3  -  W A F E R  T E M P E R A T U R E  V S .  T I M E

1 In the Model Builder window, click Study 3.

2 In the Settings window for Study, type Study 3 - Wafer Temperature vs. Time in 
the Label text field.

3 Locate the Study Settings section. Clear the Generate default plots check box.

Step 1: Time Dependent
1 In the Model Builder window, under Study 3 - Wafer Temperature vs. Time click 

Step 1: Time Dependent.

2 In the Settings window for Time Dependent, locate the Physics and Variables Selection 
section.

3 In the table, enter the following settings:

4 In the table, enter the following settings:

5 Locate the Study Settings section. From the Time unit list, choose ms.

6 In the Output times text field, type range(0,5,7000).

7 Click to expand the Values of Dependent Variables section. Find the 
Initial values of variables solved for subsection. From the Settings list, choose 
User controlled.

8 From the Method list, choose Solution.

9 From the Study list, choose Study 2 - with Gas Flow, Stationary.

Physics interface Solve for Equation form

Laminar Flow (spf) √ Automatic (Time dependent)

Solid Mechanics (solid) √ Automatic (Time dependent)

Heat Transfer in Solids and Fluids (ht) √ Automatic (Time dependent)

Electrostatics (es) √ Automatic (Time dependent)

Moving mesh (Component 1) √ Automatic

Multiphysics couplings Solve for Equation form

Fluid-Structure Interaction 1 (fsi1) √ Automatic (Time dependent)

Nonisothermal Flow 1 (nitf1) √ Automatic (Time dependent)

Thermal Expansion 1 (te1) Automatic (Stationary)

Electromechanical Forces 1 (eme1) √ Automatic (Time dependent)
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10 From the Parameter value (zsp (m),flow (1)) list, choose 2: zsp=3E-5 m, flow=100 1.

11 Click to expand the Study Extensions section. Select the Auxiliary sweep check box.

12 Click Add.

13 In the table, enter the following settings:

14 Click Add.

15 In the table, enter the following settings:

16 Click Add.

17 In the table, enter the following settings:

The problem is highly nonlinear due to coupled physics and the presence of the global 
equation, so the solver settings need to be adjusted accordingly.

Solution 3 (sol3)
1 In the Study toolbar, click Show Default Solver.

2 In the Model Builder window, expand the Solution 3 (sol3) node.

3 In the Model Builder window, expand the Study 3 - Wafer Temperature vs. Time>

Solver Configurations>Solution 3 (sol3)>Time-Dependent Solver 1 node.

4 Right-click Study 3 - Wafer Temperature vs. Time>Solver Configurations>

Solution 3 (sol3)>Time-Dependent Solver 1 and choose Fully Coupled.

5 In the Settings window for Fully Coupled, locate the General section.

6 From the Linear solver list, choose Direct, spatial mesh displacement (spf).

7 Click to expand the Method and Termination section. From the Nonlinear method list, 
choose Automatic highly nonlinear (Newton).

8 In the Maximum number of iterations text field, type 200.

9 In the Study toolbar, click Compute.

From the results of Study 1, plot the wafer profile.

Parameter name Parameter value list Parameter unit

flow (Mass flow in SCCM) 100 1

Parameter name Parameter value list Parameter unit

zsp (Z-coordinate of setpoint) 30[um] m

Parameter name Parameter value list Parameter unit

Q_plasma (Plasma heat flux) 1E5 W/m^2
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R E S U L T S

Wafer Profile, Without Gas Flow
1 In the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, type Wafer Profile, Without Gas Flow 
in the Label text field.

Line Graph 1
1 Right-click Wafer Profile, Without Gas Flow and choose Line Graph.

2 In the Settings window for Line Graph, locate the Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 8 14 21 27 32 35 in the Selection text field.

5 Click OK.

6 In the Settings window for Line Graph, locate the y-Axis Data section.

7 In the Expression text field, type z.

8 From the Unit list, choose µm.

9 Select the Description check box.

10 Locate the x-Axis Data section. From the Parameter list, choose Expression.

11 In the Expression text field, type r.

12 Click to expand the Legends section. Select the Show legends check box.

Wafer Profile, Without Gas Flow
1 In the Model Builder window, click Wafer Profile, Without Gas Flow.

2 In the Settings window for 1D Plot Group, locate the Legend section.

3 From the Position list, choose Lower right.

4 In the Wafer Profile, Without Gas Flow toolbar, click Plot.

From the results of Study 1, plot VdcSP versus z setpoints.

VdcSP vs. zsp
1 In the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, type VdcSP vs. zsp in the Label text field.

Global 1
1 Right-click VdcSP vs. zsp and choose Global.

2 In the Settings window for Global, locate the y-Axis Data section.
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3 In the table, enter the following settings:

4 Locate the x-Axis Data section. From the Parameter list, choose Expression.

5 In the Expression text field, type zsp.

6 From the Unit list, choose µm.

7 Select the Description check box.

8 In the VdcSP vs. zsp toolbar, click Plot.

From the results of Study 2, plot the wafer profile.

Wafer Profile, with Gas Flow
1 In the Model Builder window, right-click Wafer Profile, Without Gas Flow and choose 

Duplicate.

2 In the Model Builder window, click Wafer Profile, Without Gas Flow 1.

3 In the Settings window for 1D Plot Group, type Wafer Profile, with Gas Flow in 
the Label text field.

4 Locate the Data section. From the Dataset list, choose Study 2 - with Gas Flow/

Solution 2 (sol2).

5 In the Wafer Profile, with Gas Flow toolbar, click Plot.

6 Click Plot.

From the results of Study 2, plot VdcSP versus the gas-flow rate.

VdcSP vs. zsp
1 In the Model Builder window, click VdcSP vs. zsp.

2 In the Settings window for 1D Plot Group, locate the Legend section.

3 From the Position list, choose Lower right.

4 In the VdcSP vs. zsp toolbar, click Plot.

VdcSP vs. Gas Flow
1 Right-click VdcSP vs. zsp and choose Duplicate.

2 In the Settings window for 1D Plot Group, type VdcSP vs. Gas Flow in the Label text 
field.

3 Locate the Data section. From the Dataset list, choose Study 2 - with Gas Flow/

Solution 2 (sol2).

Expression Unit Description

VdcSP 1 State variable VdcSP
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Global 1
1 In the Model Builder window, expand the VdcSP vs. Gas Flow node, then click Global 1.

2 In the Settings window for Global, locate the x-Axis Data section.

3 From the Axis source data list, choose flow.

4 From the Parameter list, choose Parameter value.

5 In the VdcSP vs. Gas Flow toolbar, click Plot.

VdcSP vs. Gas Flow
1 In the Model Builder window, click VdcSP vs. Gas Flow.

2 In the Settings window for 1D Plot Group, locate the Legend section.

3 From the Position list, choose Upper right.

4 In the VdcSP vs. Gas Flow toolbar, click Plot.

From the results of Study 1, create a surface plot of the displacement.

Displacement, Without Gas Flow
1 In the Home toolbar, click Add Plot Group and choose 2D Plot Group.

2 In the Settings window for 2D Plot Group, type Displacement, Without Gas Flow in 
the Label text field.

Surface 1
1 Right-click Displacement, Without Gas Flow and choose Surface.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type solid.disp.

4 From the Unit list, choose µm.

5 Select the Description check box.

6 Locate the Coloring and Style section. Click Change Color Table.

7 In the Color Table dialog box, select Rainbow>RainbowLight in the tree.

8 Click OK.

Deformation 1
1 Right-click Surface 1 and choose Deformation.

2 In the Settings window for Deformation, locate the Scale section.

3 Select the Scale factor check box. In the associated text field, type 0.

4 Locate the Expression section. Select the Description check box.

5 In the Displacement, Without Gas Flow toolbar, click Plot.
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From the results of Study 2, create a surface plot of the displacement.

Displacement, with Gas Flow
1 In the Home toolbar, click Add Plot Group and choose 2D Plot Group.

2 In the Settings window for 2D Plot Group, type Displacement, with Gas Flow in the 
Label text field.

3 Locate the Data section. From the Dataset list, choose Study 2 - with Gas Flow/

Solution 2 (sol2).

Surface 1
1 Right-click Displacement, with Gas Flow and choose Surface.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type solid.disp.

4 From the Unit list, choose µm.

5 Select the Description check box.

6 Locate the Coloring and Style section. Click Change Color Table.

7 In the Color Table dialog box, select Rainbow>RainbowLight in the tree.

8 Click OK.

Deformation 1
1 Right-click Surface 1 and choose Deformation.

2 In the Settings window for Deformation, locate the Expression section.

3 Select the Description check box.

4 Locate the Scale section.

5 Select the Scale factor check box. In the associated text field, type 0.

6 In the Displacement, with Gas Flow toolbar, click Plot.

7 Click the Zoom Extents button in the Graphics toolbar.

From the results of Study 3, plot the wafer temperature versus time.

Wafer Temperature vs. Time
1 In the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, type Wafer Temperature vs. Time in the 
Label text field.

3 Locate the Data section. From the Dataset list, choose Study 3 -

Wafer Temperature vs. Time/Solution 3 (sol3).
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Point Graph 1
1 Right-click Wafer Temperature vs. Time and choose Point Graph.

2 Select Point 5 only.

3 In the Settings window for Point Graph, locate the y-Axis Data section.

4 In the Expression text field, type T.

5 Select the Description check box.

6 Locate the x-Axis Data section. From the Unit list, choose s.

7 In the Wafer Temperature vs. Time toolbar, click Plot.
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Line Graph 1

Global 1
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Line Graph 1

Global 1
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Surface 1

Surface 1
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Point Graph 1
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